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1. Introduction

This document provides information on how to install Scripture App Builder and build apps
on an Apple macOS system. It is possible to build an Android app using SAB on Windows,
Linux or Mac, but if you want to build an iOS app for the iPhone or iPad, you will need to
build it using a Mac computer.

App Builder Build Build
Platform Android Apps iOS Apps
Windows v

Linux v

macOS v v

Creating an Android app on a Mac is essentially the same process as it is for Windows or
Linux. To create a corresponding iOS app, you will need to enter a few more configuration
items.

The apps generated for iOS will run on an iPhone or iPad with iOS 12.2 or higher.

2. Installing Scripture App Builder
To install the Scripture App Builder program files:

1. Download the current Mac installer file (dmg) from the SAB website:

http://software.sil.org/scriptureappbuilder/download/

2. Double click on the file within Finder to open the disk image that contains the
Scripture App Builder application.

3. Copy the Scripture App Builder application to your Application folder. This can be
done by dragging the Scripture App Builder icon from the disk image window to the
shortcut of the Applications folder in the same window.

3. Installing Prerequisites for Android
If you want to build Android apps, you need to install the following components on your

computer:

1. Java Development Kit (JDK)
2. Android Software Development Kit (SDK)


http://software.sil.org/scriptureappbuilder/download/

3.1. Java Development Kit (JDK)

You will need version 8 of the Java Development Kit (JDK) to build apps. We recommend you
use Zulu, which is a free distribution of OpenJDK from Azul.

1. Go to the Download Zulu Builds of OpenJDK website:

https://www.azul.com/downloads/?version=java-8-lts&os=macos&package=jdk-fx

There are many downloads on this page, but the above link will filter the ones you
see (Java Version: Java 8 LTS; Operating System: MacOS; Java Package: Java FX).

2. Scroll down the page until you see the downloads under the heading Download Azul
Zulu Builds of OpenJDK:

Download Azul Zulu Builds of OpenJDK  "isianmsters 1 Release fotes

For PPC32-HF, PPC32-SPE and MIPS32

N Subscribe to Zulu Rel Updat
b buteZuaBulae st builds Contact Azul Sales

Java Version: Operating System: Architecture Java Package:

Java 8 (LTS) macQs —Any— JDK FX RESETFILTERS Older Zu

Java 8 (LTS)

8u292b10 acOs
e x86 64-bit JDK FX

Zulu: 8.54.0.21 | Latest

3. You have a choice between two different architectures: x86 64-bit and ARM 64-bit.
You can find the processor type of your machine by clicking on the Apple symbol at
the top left of your screen and selecting About This Mac. If you have one of the
newer Macs with an M1 chip, choose ARM, otherwise you will need x86 (Intel).

Once you have identified your device architecture, you have a choice between a dmg
file, a tar.gz file and a zip file. Download the .dmg file since it comes with its own
installer program.

The file you download will have a filename something like this:

zulu8.54.0.21-ca-fx-jdk8.0.292-macosx_x64.msi


https://www.azul.com/downloads/?version=java-8-lts&os=macos&package=jdk-fx

4. Double-click the file in Finder and follow the instructions in the installation wizard to
install it. By default, the installer will install the JDK to the following folder:

/Library/Java/JavaVirtualMachines/zulu-8.jdk/Contents/Home

Important: If you change the JDK install folder to something other than the default
folder, you will need to remember the location of the folder so you can tell Scripture
App Builder where to find the JDK.

3.2. Installing Android Software Development Kit (SDK)

The Android Software Development Kit (SDK) is needed for building Android apps. There are
two ways of installing the Android SDK:

1. Online: Download the Android SDK packages from the internet:
Use the Android SDK Installation wizard to download and install the command line
tools and three additional packages. This method will require an internet
connection.

See 3.2.1 for more details.

2. Offline: Copy the Android SDK files from someone else:
If you know someone who has already downloaded and installed the Android SDK,
you can copy all the files from them.

This method is especially useful in a training workshop where several people need to
install the SDK but have limited internet bandwidth.

See 3.2.2 for more details.

3.2.1. Downloading the Android SDK packages from the internet

To install the Android SDK from the internet:
1. Launch Scripture App Builder.
2. Select Scripture App Builder > Preferences from the main menu.

3. Go to the Android SDK tab, which is the second tab.



4. Click the Install Android SDK button.

@ Settings
Export Folders Build Settings Build Folders After Build Interface Files Slideshows

Code Libraries Android SDK Defaults Default Folders

Android SDK Location
The folder where the Android Software Development Kit (SDK) is located. Click 'Install Android SDK' to download
and/or install the Android command line tools and other packages.

Install Android SDK...

Android SDK Packages

You need four packages installed for the Android SDK. If any are listed as 'Not Found' below, click ‘Install
Packages...' to download them from the internet.

Tools Not Found Install Packages...
Build Tools Not Found Check Installation
Platform Tools Not Found
Platform API Not Found

OK Cancel

5. Follow the instructions on each page of the Install Android SDK wizard to download
each of the Android SDK packages and install them.

When you are asked to specify a target folder, a good place is:
/Users/your-name/Android-SDK.

Four packages will be downloaded and installed:

e Command line tools,
e Build Tools,

e Platform Tools, and
e Platform API.

If the installation was successful, you will see the version numbers displayed in
green.



® Settings
Export Folders Build Settings Build Folders After Build Interface Files Slideshows

Code Libraries Android SDK Defaults Default Folders

Android SDK Location
The folder where the Android Software Development Kit (SDK) is located. Click ‘Install Android SDK' to download
and/or install the Android command line tools and other packages.

/Users/richard/Android-SDK Install Android SDK...

Android SDK Packages

You need four packages installed for the Android SDK. If any are listed as 'Not Found' below, click 'Install
Packages...' to download them from the internet.

Tools cmdline-tools 4.0 Install Packages...
Build Tools 28.0.3 Check Installation
Platform Tools 29.0.6

Platform API Android 11 (API 30)

OK Cancel

If any of the Build Tools, Platform Tools or Platform APl is listed as “Not Found” (displayed in
red), click the Install Packages button to install them.

Click the Check Installation button to confirm that all the packages have been installed
correctly.

You can skip section 3.2.2 and go straight to section 4.

3.2.2. Copying the Android SDK files from someone else

If you know someone who has already downloaded and installed the Android SDK and is
successfully building apps with it, you can copy all of their Android SDK files to a folder on
your computer.

You need to look for the top-level Android SDK folder, such as /Users/user-name/Android-
SDK, and copy the whole folder and its contents to your computer. A location such as
/Users/your-name/Android-SDK is good. If it makes it easier, you can zip the folders and
then unzip them onto your computer.

Note that there is no setup program to run. Copying the files from one computer to another

is sufficient.
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Tip: A typical Android SDK folder can be quite large (over 1 GB, depending on which
additional packages have been installed). To build an app, you do not actually need all of the
Android SDK files. If you want to cut down the number of files, here is a list of the essential
and optional folders:

Android SDK Folder Required for building apps?
cmdline-tools (or tools) | Yes

build-tools Yes (you only need the sub-folder for the latest version)
platforms Yes (you only need android-30 for now)
platform-tools Yes

add-ons No

docs No

emulator No, unless you want to use an emulator
extras No

licenses Yes

sources No

system-images No, unless you want to use an emulator
temp No

4. Installing Prerequisites for iOS

If you want to build iOS apps and upload them to the Apple App Store, you need to install
the following components:

1. Xcode
2. Transporter

4.1. Install Xcode

Xcode is required to build iOS Apps. To install Xcode, simply search for Xcode in the Mac
App Store and install it. Open Xcode at least once to agree to the licensing restrictions and
install components.

#1 a4+
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4.2. Verify Xcode Installation

To verify that you have successfully installed Xcode and that it will be correctly used by
Scripture App Builder, please open Terminal and run the following command to print the
path to the active developer directory: xcode-select -p

$ xcode-select -p
/Applications/Xcode.app/Contents/Developer

If you have had Xcode Command-line Tools installed previously, it might still be pointing to
that installation directory and Scripture App Builder will not work correctly.

$ xcode-select -p
/Library/Developer/CommandLineTools

To correct this situation, run the following command to set the active developer directory.

sudo xcode-select -s /Applications/Xcode.app/Contents/Developer

4.3. Install Transporter

Transporter is used to upload iOS apps to App Store Connect. To install Transporter, simply
search for Transporter in the Mac App Store and install it.

Transporter

t .f"f.-;-.;l_.__.l. antent to Apple °
4.1 Sk ko iy «<D )

5. Installing Prerequisites for Progressive Web App

If you want to build a Progressive Web App (PWA) that can be downloaded from the
browser on any platform instead of going through an app store, you need to install the
following components:

1. Node.js
2. Workbox-cli

For more information on what PWAs are, why you might use them, and how to export the
files needed, see Scripture App Builder Documentation 2: Building Apps.

5.1. Install Node.js

Go to the Node.js Downloads page:

12
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https://nodejs.org/en/download/

There are many download files on this page. You are looking for the file that corresponds to
your computer’s operating system type. It is easiest to download the .pkg file (installer
package file) rather than the tar file.

Downloads

Download the Node.js source code or a pre-built installer for your platform, and start developing today.

LTS Current
Recommended For Most Users Latest Features

1 | = O
i S 5

Windows Installer macOS Installer Source Code
Windows Installer (.msi) 32-bit 64-bit
Windows Binary (.zip) 32-bit 64-bit
|: macOS Installer (.pkg) 64-bit
macOS Binary (.tar.gz) 64-bit
Linux Binaries (x64) 64-bit
Linux Binaries (ARM) ARMVT ARMvS

When the file has downloaded, run it to install Node.js on your computer.

5.2. Install Workbox-cli

After installing Node.js, open Terminal. Paste in this command and press enter:

sudo npm install workbox-cli -global

Once this command finishes running, you have the prerequisite tools for exporting PWA
files. Close SAB if it is open and restart it.

6. Installing Aeneas

Aeneas is the audio-text synchronization tool that may be run from within Scripture App
Builder to create timing files for phrase-by-phrase highlighting. If the apps you are building
do not include audio or if the timing files are already available, then there is no need to
install it.

To install aeneas:
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1. Download the aeneas tools for Mac file (dmg) from the SAB website from the
section labeled Audio Synchronization Tools:

http://software.sil.org/scriptureappbuilder/download/

2. Double click on the file within Finder to open the disk image that contains the
aeneas-mac-setup install package. Control-click on the install package and select
Open. You will get a warning that this package is from an unidentified developer.
Press Open.

3. The introduction screen will display. Press Continue.

(0] « Install aeneas tools

Welcome to the aeneas tools Installer

This will install aeneas 1.7.2 on your computer.

+» Introduction ;
aeneas is a Python library and a set of tools for automated audio and text

synchronization.

In addition to aeneas, the following independent programs necessary for
running aeneas are contained in this installer:

1. FFmpeg

2. eSpeak

3. Python

You will be guided through the steps necessary to install this software.

Continue

4. A “Read Me” screen will display next followed by a “License” screen. Press Continue
on both screens.

5. Pressing the Continue button on the License screen will bring up a screen asking if
you agree to the terms of the license. Press Agree.

6. The “Destination Select” screen selects the default drive. Press Continue.

7. The “Installation Type” screen displays next for a standard install. Press Install.
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1] w Install agneas tools
Standard Install on “Macintosh HD

This will take 227.1 MB of space on your computer.

Introduction

Read Me Click Install to perform a standard installation of this software
) on the disk "Macintash HD"

License

Destination Select

Installation Type

Change Install Location...

Customize Go Back Install

8. The installer will prompt for credentials to install the software. Enter a username
and password with permissions and press Install Software.

9. At this point the installation will start and will show progress screens until it
completes. A terminal window will popup briefly to test the installation. When the
application completes successfully, the original screen will show:

] w Install aeneas tools

The installation was completed successfully.

Introduction

Read Me

License
Drestination Select

Installation Type The installation was successful.

Installation The software was installed.

Summary

10. Press Close.

Aeneas is installed in /usr/local/lib/python2.7/site-packages.
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7. Testing App in iOS Simulator

When you want to test your app, you can either use a device or a simulator. To test with a
device, you will need a signing certificate and provisioning profile (see next section). To test
with a simulator, you will need to download Xcode, the integrated development
environment used to build and test iOS and Mac apps. Xcode is available for free in the Mac
App Store and is quite large (5.46GB). SAB requires Xcode 9 or greater (which requires
macOS Sierra). To install:

1. Go to https://itunes.apple.com/us/app/xcode/id497799835?mt=12 or search for
“Xcode” in the App Store app on macOS.

2. Install from the App Store.

3. Start Xcode at least once to complete the installation.

7.1. Run the iOS Simulator

Once you have a project configured and ready to test, click on the Run iOS App in Simulator
on the toolbar.

L Run 05 Simulator

To launch an app in the simulator
1. Start the simulator

Sirnulator Type iPhone X = 11.1 H Start
Z. Build and launch the app

Project Name Kuna Gospels v | Build

Last Built Mot Built Yer

Close

Select the simulator you would like to run on and click Start. It takes a little bit of time for
the simulator to start. If you want to switch simulators, select a different Simulator from the
Simulator Type combo box and click Start again. It will close the previous Simulator and
start the new own.

Select the project you want to test (it defaults to the selected project in the Apps list) and
click on Build. This will build the app for the Simulator in a separate terminal window.
When the build is complete, you can click on Launch to run the app in the Simulator.

You may close the dialog and make changes to your project. When you restart the Run iOS
Simulator dialog again, you will need to Build and Launch again for the changes to be
included.
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7.2. Installing Additional Simulators

You may install simulators for previous versions of iOS by launching Xcode and viewing the
preferences dialog and selecting the Components tab.

] L] Componsnts
@) ® 4 / B = 2

General ADcousts Behaviors Mavigation Fonis & Colors Tt Editing Koy Bingings Sownce Conirol Components Locations Server & Bots

Bl o Bare

25 1.0 Smglator .08 Ga
0% 101 Simulaor 108 G&
05 102 Siradates io3oa
05 0.8 Shmeslanor 1868
0% 10uD Sirmeslator 180 GB
0% 0.3 Simuleer
05 0.2 Simlane 14008
05 B Smadstor .48 G8
25 B0 Fmalstor 146 GE
0% B Simulinos 137 Ca
05 B.3 Simulano 1.36 08
05 B.2 Smialator 132 ca
0% 11 Simalator AREL - |
Check Tor and irnstall smulaton updales aulcmatically Check and Install Now

7.3. Manually Installing Apps into the Simulator

If there is a problem with launching the simulator from the Run iOS Simulator dialog, you
can manually install the app by dragging the built app from the Simulator output folder
(found in ~/App Builder/Scripture Apps/Sim Output) onto the Simulator.

To start the Simulator, launch Xcode and from the Xcode menu select Open Developer Tool
> Simulator. You will still need to rebuild the app from the Run iOS Simulator dialog.

8. Creating iOS Certificates and Provisioning Profiles

8.1. Enroll in the Apple Developer Program

To build iOS apps and distribute them through the Apple App Store, you will need to be
enrolled in the Apple Developer Program. You can do this as either (i) an individual, or (ii) an
organisation. The cost is USD $99 per year.

To enroll:

1. Go to https://developer.apple.com/programs/enroll/

2. Press the Start Your Enrollment button to start.
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8.2. Create Signing Certificate

When you create an iOS app, it needs to be signed with a certificate.

To create a certificate:

1.
2.

3.
4.

Go to the Apple Developer website and log in to your account if you are not already.

Select Certificates, Identifiers & Profiles.

Click the @ button to the right of the Certificates header.

On the Create a New Certificates page, select Apple Distribution. Then press the
Continue button.

Upload a Certificate Signing Request. Press the Learn more link for instructions on
how to use Keychain Access on your Mac computer to complete this task. Then press
the Continue button.

On the Download Your Certificate page, press the Download button to download
the certificate (distribution.cer) to your Mac.

Open the Keychain Access application. Choose the login item from the Keychains
section on the left. Choose the File > Import Items... menu item and browse to the
Downloads folder and select the certificate (distribution.cer).

Now that the certificate is installed in the Keychain, you will be able to access it from within
Scripture App Builder.

Note: To work with certificates, you will need the Apple Worldwide Developer Relations
(WWDR) Certification Authority. It should have been installed with Xcode. When viewing
your certificate in the Keychain Access application, if there is an error stating the certificate

is not trusted, then install the certification authority.

To get the certification authority:

1.

Download the Apple WWDR Certification Authority from:
https://developer.apple.com/certificationauthority/Apple WWDRCA.cer

For signing certificates created after January 28, 2021
https://www.apple.com/certificateauthority/Apple WWDRCAG3.cer

Open the Keychain Access application. Choose the System item from the Keychains
section on the left. Choose the File > Import Items... menu item and browse to the
Downloads folder and select the certification authority (Apple WWDRCA.cer). You
will be prompted for a username and password that has admin privileges in order to
modify the System Keychain.
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3. Choose the File > Lock Keychain “System” menu item.

8.3. Create Provisioning Profile

Distribution provisioning profiles are used to for two primary purposes:
e AdHoc - to install your app on a limited number of registered devices for testing.
e App Store - to submit your app to the App Store.

Creating a provisioning profile
To create a new AdHoc provisioning profile, you will need an App ID and at least one

registered device. To create a new App Store provisioning profile, you will need just the App
ID.

To create an App ID:
1. Gotothe Apple Developer website and log in to your account if you are not already.
2. Select Certificates, Identifiers & Profiles.

3. Select Identifiers on the left of the page.

4. Click the ® button to the right of the Identifiers header.
5. Select App IDs and click the Continue button.
6. Select App and clock the Continue button

7. Enter a Description of your choice.
It can be the App Name from the App > Package page of Scripture App Builder.

8. For Bundle ID, choose Explicit and enter your app package name from the App >
Package page of Scripture App Builder.

9. Of the App Capabilities, there are only two that may need to be checked. Check the
Push Notifications capability if the app uses Firebase Cloud Messaging, Verse of the
Day, or Daily Reminders. Check the Associated Domain capability if using Deep
Linking.

10. Click the Continue button.

To register a device (i.e. a specific iPhone or iPad for testing):

1. Select Devices on the left of the page.

2. Click the @ button to the right of the Devices header.

3. Inthe section Register a Device, enter a name of the device (such as “John Smith’s
iPhone”) and its UDID (unique device identifier, a sequence of 40 letters and
numbers). Press Continue.
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4.

On the next page, check that the device information is displayed correctly and click
Register to confirm.

Note that you can register up to 100 devices of each type (e.g. up to 100 iPhones,
100 iPads) per year of your Apple Developer Program membership. You can remove
devices that you no longer need at the beginning of the next membership year.

To create a provisioning profile:

1.

2.
3.

Select Profiles on the left of the page.

Click the @ button to the right of the Profiles header.

On the Register a New Provisioning Profile page, under Distribution, select Ad Hoc
(for testing) or App Store (for submission to the App Store). Click Continue to move
to the next page.

On the ‘Select an App ID’ page, select the App ID from the list of App IDs you have
already defined. Click the Continue button.

On the ‘Select Certificates’ page, select the certificate (Distribution) to include in the
profile. Click the Continue button.

If creating an AdHoc provisioning profile:
On the ‘Select Devices’ page, check the device(s) that you want to be able to install
and run the app. Click the Continue button.

On the ‘Review, Name, and Generate’ page, give the profile a name of your choice. It
is helpful to include “App Store” or “AdHoc” in the name. Click the Continue button.

On the ‘Download and Install’ page, click Download to save your new
.mobileprovision file to your computer.

This is the Provisioning Profile file that you will select in Scripture App Builder.

Download existing mobile provision files

If other members of your team have already created provisioning profiles, they can be

downloaded from the App Developer website by selecting the profile to be downloaded and

pressing the Download button.

9.

Building an iOS App

The first step in building an iOS app is to create a new app project following the instructions

in the SAB Building Apps document. Then follow the instructions below.

9.1. Application builds available for iOS

For iOS distribution, three different app types are available.
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9.1.1. Dedicated App

This is the standard traditional app and is the default. The content that is defined for this
project will be used to generate an iPA file that may be delivered to the App Store for
publication. A dedicated app could be viewed as a container app that only runs one
preselected asset package that is included in the app at build time.

9.1.2. Container App

App Builder users have encountered issues with the Apple App Store reviewers if too many
apps generated by the App Builder are published to the same account. Since the actual
application differs only in the content provided, Apple rejects the app as being spam. To
avoid these issues, a container app can be generated instead of the standard dedicated app.

The container app does not contain content of its own. It does not have book collections,
audio or any of the other normal content. Instead, on its initial startup, it accesses a web
site that is maintained by the app developer. The web site provides specially formatted
links to multiple asset packages. The app user selects one of these asset packages. The
container app downloads it and runs using the downloaded content. From this point, it
resembles the dedicated app, running this set of content without further downloads being
required.

The user of a container app does have the option of resetting the content at any time. If the
user elects to reset the app content, the app asset package currently in use is deleted from
his device. The web site accessed at the initial startup is displayed, and the user can once
again select the asset package to be run from the available list. The selected package is then
downloaded and run in place of the discarded one.

Building a container app will generate an IPA file similar to the dedicated app with the
exception that no content is included with the app beyond some configuration information
and a reference to the website used by the app. The IPA file is submitted to the Apple App
Store in the same manner as the dedicated app.

While most of the settings associated with the app need to be set in the asset package
projects, there are a few settings that must be set at the container app level. The first of
these are the Firebase related features. Firebase tracks at the app level, and the settings for
the Firebase tab and the Security tab will apply for all app asset packages associated with
this container app. The GoogleService-Info.plist file that is used by the iOS Firebase
configuration should be associated with the Package Name for the container app set on the
package tab. Firebase will track information associated with the container app, not with the
individual asset package projects. A project field is included in events generated by asset
packages and sent to Firebase and can be used to identify the events that originated with a
particular package that is being distributed.
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Several other features follow the settings in the asset package project definition but must
be accommodated by the container app that loads them. If any of the asset packages that
can be loaded by this container app application use Verse of the Day or Daily Reminder
features on the Notifications tab, these options must be enabled in the container app as
well as in the asset package that wants to use the feature. The same applies for the Verse
on Image feature. While the backgrounds and watermarks that are available are set in the
asset package project, if any asset package that can be loaded by this container app
application uses the Verse on Image feature, then the Include the “Verse on Image” editor in
the app checkbox on the Verse on Image tab must be checked here, as well as in the asset
package that wants to use the feature. The /PA tab also includes a checkbox that must be
selected if any of the asset packages include audio files.

On the Images tab, the iOS Icon and the iOS Splash Screen (optional) should be configured
for the container app as these will be the images used. The images set in asset packages for
these two items will not be used.

9.1.3. Asset Package

Asset packages are used in conjunction with Container Apps. The configuration of an asset
package project should be the same as it is for a dedicated app, setting the book collections,
audio and feature required for that app. The only exceptions are those mentioned in the
section above on Container Apps. However, where the build of Dedicated Apps or
Container Apps results in an IPA file to submit to the Apple App Store, the build of an Asset
Package project results in a zip file, saved to the IPA output folder, that is intended to be
saved to a location where it can be referenced by the web site supporting the Container
App. A user running who has downloaded the Container App from the App Store will select
this package from the list presented by the Container App Web Site, at which point it will be
downloaded to the device, decompressed and run as the project for the app. All of the
book collection, audio, font, images, features and configuration information that is usually
embedded within the dedicated app is saved in this zip file so that the project can be run as
it would if it were configured as a dedicated app.

Dedicated Apps and Container Apps can only be generated on an Apple Mac device. Asset
Packages do not require a Mac. Therefore, App Builder can build a project configured as an
iOS Asset package on a Mac, a Linux device, or a Windows device. On a Mac Device,
selecting Build iOS App for a project configured as an Asset Package will generate the zip file
in the IPA Output Folder. For testing purposes, so that the app developer can test the
device outside of the container app, selecting Run iOS App in Simulator will cause an IPA file
to be generated in the Simulator Output Folder that will run using the project configuration.
The app developer can load the IPA file on an iOS device simulator and test the project
before generating the zip file and adding it to their Container App web site.
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9.1.4. Container App Website

While not generated by App Builder, a Container App project must have a web site where
the asset packages are located and a web page is defined by the user to allow selection of
the asset package. The Container App displays the web page referenced by the URL that is
part of its configuration. Anything other than links that reference
asset.//yourwebsite/yourassetpackage.zip or https://[something].zip or

http://[something].zip are passed through the browser and are displayed to the user. When

the user selects a link that starts with asset:// or a normal URL that ends in .zip, that is
interpreted as the selection of an asset package. If the URL starts with asset://, the asset://
in the link is replaced with https:// to generate the destination URL. The file referenced is
downloaded, unzipped, and used to initialize the Container App. A very simple example of a
Container App Website web page would be:

<html>

<head>

<style>

.container {
display: flex;
justify-content: center;
background-color: powderblue;
font-size: 40px;

}

.center {
width: 800px;

}

</style>

</head>

<body>

<p id="top" class="container">Container App Test</p>

<div class="container">

<ul> Select a translation

<li><a href="asset://sab-assets-test.s3.amazonaws.com/EnglishGreek2.zip">English
Greek</a></li>

<li><a href="https://Test.zip">Test</a></li>

</ul>

</div>

</body>

</html>
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https://[something].zip/
http://[something].zip/

9.2. App Type (iOS) Tab

engWEB World English Bible
scp-Hyalmo Bible

[ ] ® Scripture App Builder
New App... Save Save Al Build Android App Install APK... Build PWA Run PWA  Build PWA Data Files Build iOS App  Run iOS App in Simulator Q, Find... 3 EN
Apps WEB Gospels: A
v [ WEB Gospels B S
® App App Name Package Project APK  App Type (0S) IPA  Signing (Android) Signing (0S) Expiry Security Permissions
® About —e e
Appearance
Data & Analytics App Type
Publishing If you have a Mac, you can create iOS apps using the App Builder. These can be of two types: a dedicated app, or a container app. When a user launches an
Navigation i0S container app, they are given the choice of a number of different app options. Each option is defined using an Asset Package, which is downloaded and
Engagement installed after the user makes their choice.
Media Although you need a Mac to make the iOS app, you can build the Asset Package on any platform. To do this, specify a filsname below and select Build >
® Books Build iOS Asset Package.
SAB Test Select the type of app to be created by this project:
Kuna Gospels
Simph\‘ied‘fresl ®) Declcated App (Dofoutt

Container App: displays a web page which allows user to select asset package to download and use

dyu-Dioula (Jula) Bible T L
Scripture Earth Container
Ingush - Ruth 108
scp-Hyolmo Bible

WEB British Edition

Test Container A F
EnglishGreek2

UZB Mugaddas Kitob (i0S)

BloomBook2

TestWithBloom

Asset Package: a zip file containing all app contents

The App Type information identifies the type of application being built, as defined in
the previous section. Select either Dedicated App, Container App, or Asset Package.

If the Container App option is selected, the Container App URL needs to be entered.
The URL entered here is the web page that will be displayed to the user by the
container app to allow them to select the asset package to be used. The checkbox
underneath it must be selected if any asset package used by the Container App will
contain audio for books.

If the Asset Package option is selected, the Filename field under the Asset Package
option is enabled. This field defines the base name, without path, that will be
assigned to the Asset Package zip file. The file will be created in the IPA Output
folder when the user selects Build iOS App (or on a Linux or Windows system, selects
Build iOS App Asset Package.
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9.3. IPATab

[ ]

New App...

®

Apps

v I WEB Gospels

® App

® About
Appearance
Data & Analytics
Publishing
Navigation

Kuna Gospels
Simplified Test

engWEB World English Bible
scp-Hyolmo Bible
dyu-Dioula (Jula) Bible
Scripture Earth Container
ingush - Ruth iOS
scp-Hyolmo Bible

WEB British Edition

Test Container
EnglishGreek2

UZB Mugaddas Kitob (0S)
BloomBook2

TestWithBloom

Balochi Mestag Arabic-Latin
TestCUK

Test

Save Save All Build Android App  Install APK...

Seripture App Builder

Build PWA Run PWA  Build PWA Data Files  Build iOS App  Run iOS App in Simulator Q Find... ¥ EN

WEB Gospels: App

App Name Package Project APK  App Type (i0OS) IPA  Signing (Android)  Signing (0S) = Expiry Security Permissions

IPA File

The IPA file is the iOS app package file generated by App Builder. This is the app installation file you distribute to others via the Apple App Store.
Filename WEB_Gospels.ipa

Build 1 (Add 1 for every app release. Not seen by user.)

Version Name 2 [} [} (Seen by user.)

Append version name to base ipa filename, e.g. WEB_Gospels-2.0.ipa

Apple ID
Specify the Apple ID from App Store Connect. It will be a nine digit number.

Apple ID

Bundie ID

Select the Bundle ID for this app:
® Use Package Name (Defauit)

Specify a Bundle ID

Click on the IPA tab.

This allows you to set the name of the ipa file to be generated as well as the build
and version information.

The fields on this page, under the IPA File, Apple Id and Bundle ID headers are only
enabled for a Dedicated App or Container App, as defined in the App Type tab.

The Filename field on the screen for the IPA File section specifies the base name of
the ipa file to be generated. If the checkbox at the bottom of the screen for Append
version name to ipa filename is checked, then the version indicated by the Version
Name fields is added to the base filename.

The Build field referenced as Build is also called Bundle Version String, Bundle
Version or CFBundleVersion within Xcode and ITunes Connect. It represents the build
number. The Build field expects an integer value and should be incremented with
each file that is submitted to the ITunes Connect for release or testing.

The Version Name field is referenced as Version, Bundle Short Version String, Bundle
versions string, short and CFBundleShortVersionString within Xcode and ITunes
Connect. The field is created as a concatenation of the values of the three fields
separated by a period. If the final field has a value of 0, then the version string is
created from just the first two values. So for values of 1, 2 and 0, the resulting string
is “1.2”. For values of 1, 2 and 3, the resulting version string is “1.2.3”.
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The Apple ID field is the id assigned by App Store Connect to the application in the
app store. It can be obtained from Apple ID filed on the App Information tab in the
App Store Connect entry for the app as shown below

A App Store Connect Apps Users and Access

Kuna GOSpElSV App Store Features TestFlight

i0S App App Information

1.0 Prepare for Submission This information is used for all platforms of this app. Any changes will be released with your next app version
Add macQOS App

Add tvOS App
@ You can now set your app's age rating from the App Information page. The Gambling and Contests content descript
describe your app's content more accurately. Edit Age Rating
General
App Information
Pricing and Availability Localizable Information
App Privacy Name ?
Ratings and Reviews Kuna Gospels
Version History

In-App Purchases Subtitle ?
Manage

App Store Promotions

General Information

Bundle ID 7 Primary Language 7
org.wycliffe.app.test.cuk ~ English {U.5.)
Category ?
SKU 7
KUNA Primary
Secondary (optional)
Apple ID 7

1346657481

The Bundle ID section allows the user to specify a Bundle ID for the app that is
different than the package name. By default, the Package Name field from the
Package tab is used as the Application Bundle ID that is used in creating the
provisioning profiles and as the application identifier for the Apple App Store. If the
user wants the iOS version of the app to have an identifier that is different than the
package name that is used for the Android version of the app, press the Specify a
Bundle ID button and then enter the ID to be used in the text box labelled Bundle ID.

9.4. Signing (iOS) Tab
1. Select the Signing (iOS) tab to open the iOS signing options for the app.
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& 08 Scripture App Bulder
MNew Azp Sawn Al Buid Android Apg Buid K% App Buikd Mubighe Agpu Run K% App = Simulator

*

B ApRS Kuna Gospels: A
iuna Gospets | il

App Mams Package Froject AP kA Signing trgroad)  EEEETTLEEEE ] Lapuiry Security Permiiisans

Please specify the sigréng identity and prosissoning profile to configure this app for K05,

Sigmimng Mdentity

The signing identity is uied to Hign the app with & certificate 55 that uiers will ke that the app can B trasted and
has mot been tampered with.,

\dentity iPhone Developer St D"y 7] Rleesby
Proswishoning Profile

The provisioning peofile is uied to astocian the apg with specific W05 deviced, tuch & your dinige and othen wha
are on your app development and testing team. You can download this file from the Apple Developer Portal,

Profile File U sers ! haabibard  Doswnload s  orgwycliffeappoui bible_Dew. mobileprovision Bremie.

Prodile File Properties

Type debug
App Id arg.wycliffe app.cuk, bible
Teasn d
Direigins
C— —
e e i ———m——
———— e i T—— - T s T

Select the Signing Identity from the drop down list of signing certificates which have
been downloaded and installed to this system in the earlier steps.

For the Provisioning Profile entry, enter or browse to the mobile provisioning file
associated with the app that was downloaded in the earlier steps.

27



4. Click on the Build iOS App button at the top of the screen. A terminal window should
open. The build script for the iOS App should run within that terminal window.

Frm App Save All| | Build Ardroid App | | Build 0% Aps || Buid Multiple Apga Fen i00% App in Grrulser
= AppS
k
App Mame  Package  Project  APK Sigming (Androidi  Sigréng 0081 Expiry  Secwrity  Permisdiond
BPA File
Thie BPA Tl b6 thi 105 app pachage file generated by App Builder. This is ths app isseallaion file vou distibuang ta
cihery wia the Apple App Stane
Filename Kuna_Gospels.ipa
Bkl 1 I (Add 1 fer every ape melease. Not seen by user.)
Wdiion Marms i ]| = 0 T Chesn by uier)
+ Append version name 1o base ipa filename, e.q. Kuna_Gospels-1.0.ipa
L= - Build-asppah — B0= 14
Flasndign Tesp Papload/Kuss Soseale-1.0.4pp! peplacing exlating signeture L]

re: _floatafgnfespiold-estedded-prafile.pliss: Mo swch file as directasy
L1415 380

Resigmed the sgp

Copyisg Epe o output faldsar

Copyleg i05 Apg Tcon File

Signed releane TPA budlt succemsfully.

Twa 1 Bublapd ateff IPDLIAPES Bee 1 16018 Suserd/Rubbardflgp Bullses/
Scripfure Agpeilpa Qutput/Musa_Gomgele-1.0.1ipa

Logaus

Seving stdalon.. .

.-copyisg shaced histery...

o opawing higieTy.. . trencating Blstory files...

o aEELETEN,

[Process complated ]

5. Examine the terminal window once the shell script has been completed. The
message “Signed release IPA built successfully” should appear in the window if the
app has been built successfully. (Note that occasionally the terminal window will
appear behind the Scripture App Builder and that you have to select the terminal to
review the results).

6. The results of the build are an IPA file and an app that can be run in the simulator.
They can be found in ~/App Builder/Scripture Apps/Ipa Output/ and ~/App
Builder/Scripture Apps/Sim Output/.

MName -~ Date Modified Size Kind
» | Apk Qutput Today, 11:24 AM - Folder
» [ App Projects MNowv 29, 2017, 2:33 PM == Folder
¥ || Ipa Qutput Today, 2:19 PM - Folder
I Kuna_Gospels-1.0.ipa Today, 2:15 PM
¥ [ Sim Qutput Today, 2:19 PM - Folder
-y Kuna_Gospels-1.0 Today, 2:15 PM 185.7 MB Application

28



10. Testing an iOS App

After building the iOS IPA file, you will want to install it and test it on one or more devices
before you submit it for publication to the Apple App Store. This manual describes two ways
of doing this:

1.

Use Xcode to install the IPA file to an iPhone or iPad that is connected to your
computer.

This method is recommended if you have your test devices with you. It does not
involve uploading and downloading the IPA to and from the internet.

Use DeployGate to upload the IPA file to the internet and share it with limited
number of devices to download, install and test.

This method is recommended if you have good internet access and/or you have a
team of testers who are elsewhere.

11. Using Xcode to Test an iOS App
To test your iOS IPA file using Xcode, do the following:

1.

2.

3.

Launch Xcode and select Window > Devices and Simulators.
Connect an iPhone or iPad to the Mac using a cable and unlock the device.

On the Mac, iTunes may launch and show a dialog asking “Do you want to allow this
computer to access information...” Click on the Cancel button.

e Note: This feature can be turned off in iTunes. Select iTunes > Preferences...,
select the Devices tab, and click on the Prevent iPods, iPhone, and iPad from
syncing automatically checkbox.

On the device, it may prompt to Trust This Computer. Tap on the Trust button. This
may require to enter the Passcode to trust this computer. The device will show up in
the Xcode Devices window.

The first time the device is connected to the Mac, Xcode will take some time to
Prepare debugger support. This may take some time. Please wait.

In the Xcode Devices window, there will be a section named INSTALLED APPS. Click
on the + button.

Find the IPA file to add. Click Open after you have selected it.
Click the Install button next to the name of the app.

Wait until the Mac installs the app to your device.

After the install is complete, you will see the app icon on your device and you can test it.
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12. Using DeployGate to Test an iOS App

DeployGate enables you to test your app and share it with a limited number of users to test.
You upload the IPA file for iOS apps or the APK for Android apps and then download them to
your phone or tablet device. You can also invite testers to install your app and help with the

testing.

A DeployGate app is installed on the testing device. It will show all of the apps that you have
uploaded to DeployGate and allows them to be installed on the device.

12.1. Creating a DeployGate Account
The first step is to create a DeployGate account. To do this:

Go to https://deploygate.com

Press the Get Started button.

Enter an email address, a user name and a password.
Press the Sign up for DeployGate button.

el

deploygote Features Pricing Developer Tools Support Log in Signup

Sign up -

for DeployGate

Username
Please read our Terms of Service and Privacy Policy before proceeding.

© with GitHub Account Password

& with Google Account By clicking the button, you agree to the terms.

Sign up for DeployGate

12.2. Uploading Your First App

Once the sign in screen has been successfully completed, you are presented with a screen
that prompts you to upload your app. While there are several methods described for
embedding it as part of your build process, the way we have used this to date is to simply
upload the IPA file that has been created by locating the ipa file in Finder and then dragging
it to the bottom area of the screen where it has a green Upload App area:
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https://deploygate.com/

OGD{OYQOQO Gebdoed  Deeipe Tooh  Swsen | | Sveowio

Hi dmoore1768, welcome to DeployGate!

DepOyGate Maes & easy 10 $re N-deweiopment 105 90 And ol sp0s,

Fowrg Users 0 aTHeSsYy and suctessiuly Drogres OYDINE CEVE0OMETE, Ie31Ng 70 Mar«etng stages of

Let's get started with your own device and see how it works:

RREUVTTECTRETNY B 2 Loginonyour device B 3. Install

® 105 app & Android app
S04 g Bt g acte L0 gan SLMNET

e L i L L T

et "comdplomneigreia 1LAAT /7 a8 thin L

O oo &g and deop your APIPA Sle here

Dragging the file to the upload area causes a new dialog to be displayed with the name of
the file and a text box where you can enter a short note that will be displayed on your
profile window and also on the DeployGate app when the user is selecting the app. It is a
good place to write a short note on the reason for the update so that it is easy for the
testers to see that the app has been updated and to see what the primary reason they need
to update is. Complete the screen and press the Upload button.

Upload App File

Filemame San_Blas_Kuna.ipa

Release note Testing ducumencaliorl

Privacy Mode Daon't show on your profile
(Upgrade my account)
‘Your app packages and data are always kept privately
an DeployGate. Choose this to hide even title and icon
from your profile and make the app completely secrat.

Cancel
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When the upload is complete, a new dialog is displayed with a QCode bar code and the
option to send an email to your device. The QCode can be read in with your iPhone or iPad
which will trigger an installation of the DeployGate app using your app profile.

Alternatively, you can enter an email address at this point, which you would also open on
the iPhone to install the DeployGate app with the correct profile. Or you can simply go on
and add users and devices later.

+ Your app has been uploaded!

To download and install the app on your device, email a download link to the dewvice.

& Email a link to your device

dmeoorel 768Ehotmail | Send

. San Blas Kuna 1.0({2]#1

After this, the screen that is displayed is what you will normally see when you login. The
screen has an entry for each app that you have uploaded. It has an Upload App button that
can be used to upload new versions of the same app or to upload a new app.

dep{oygote Dushboard  Develcper Tocls  Suppont emcoret 768

ng wycete sop ok btie 18123 #0  @vkieonoretie W OISTRIBUTIONS

& San Blas Kuna [ [0 o
13 ¢ et ach Bk can
#1Testng coaumentation ROR favr s Serest versicn o

Sand 20 Youw Own Devices SORCode B Emad
© Opions « & TESTERS
7’
% AP KEY
ACUIVILIES Aot aavae - -

WAL & Craches 2e0dse1 257000205430 | &

B2 ameoret D68 uplosded & new app “San Blas Xuse*

8 DDNCE DATA

= No tracking dra yet

12.3. Registering a Device
If the iOS device was not originally in the mobile provisioning profile and if the device has
not been previously registered in your Apple Developer account, you need to add it to both.
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There is a method for manually doing this, but DeployGate provides a way of simplifying the
process so that you don’t need to go and look up UDID for the device.

First, try to install the app using the method described above. You will not be able to install
it because the UDID is not registered for the app. However this will result in the device being
registered in DeployGate which allows the following steps.

After attempting to install the app, re-enter DeployGate in your browser and open the entry
for your app. As you can see in the screen below, it will show that a new UDID has been
registered for the device. Press the Options button below and select the Package Archive
option. Next click the little tag symbol inside the app box to open the UDID list.

deploygote Dashboard Developer Tools Support dmoore1768
org kalasrn test. ScriptureApp 1.0 (2) & Q@ Visitie o0 peofile & DISTRIBUTIONS
Test =23 =
A
#1 Kalaam profile :_-gi -
j__-,.“ oad A O ASd 3 link for sharing
BQRCode WImall & TESTERS
O Options =
& De
-l
=p
% AF1 KEY
2] % ap
Actlvities
3 LY
BA AcCrave
© dmooce 1748 registernd a new UDID
B denoore 1768 uploaded a new app “Test™ = DEVICE DATA

The next screen shows a list of the devices that have been observed by DeployGate or that
were included in the provisioning profile. Your new device entry will show up on the screen
with a Not Exist entry. Make sure that the entry for the new device is checked and then
press the Export Selected UDIDs button. This will create a file “multiple-device-upload-
ios.txt” that can be used on the Apple Developer website to add these devices to the mobile
provisioning file.
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dep[ol};gota Dashboard  Developer Tool Supper dmeorslT58

. Test by dmoore1768

Teid | Package Archive | UDID Lok of MemEer and Rareridon #1

H some LIDIDS are "ot Exisn™ in the peofle. this app can't be instalied oo thase dewioes
I that case, seport LINDs o & e, thawn import | ot "Cartificates, idensfiers & Profiles”, re-oreate & profils with thous devices.

Expon Sslscted UDIDS

show 10 & mirm Smarch: o
= UstR BOLE PRODLULT uoin PROVIEIDONING FROFILE
[~} dmoore 1 TER =l el 3 0N SO Thad 1 a5 bt | 31 M Gelcid 5acfl 17 Mot Fxier
a Fhona & iGlshal] FcIAMEARINE LI L0 4 TU TG adacShT Eant
Showing 1 bz 1 of 3 entries T - Mgt

After logging in to Apple Developer, click on Certificates, IDs and Profiles. Press the All
selection under Devices as shown in the illustration below and then select Register Multiple
Devices. Then press the Choose File button.

SEITUINAGLED, IUSHIUNSID W TIvIine> e ——
i0S, tv0S, watchOS - Add Devices +/ 7 Q

7 Certificates '-

All

Pending

Registering a New Device or Multiple Devices

Development

Prodection
8 Mentifiers

App IDs

Pre-Rel Software
Pass Type IDs You may only share Apple pre-release software with employees, contractoes, and members of your
Wedsae Push 105 organization who are registered as Apple developers and have a demonstzable need to know or use Apple

Software 10 develop and test applications on your Dehal!
1Coed Containers

App Croups Unauthorized distribution of Apple confidential Information Including pre-release software) is prohibvted and
mary resull in the termination of yose Apple Developer Program. It mmay also subject you 1o ¢ivil and creminal
Merchant IDs
Hakility,
U Devices
All
Apple TV
Register Device
Avple Watch Name your device and enter its Unique Device [dentifier (UDID).
Pad
Nam
Phone e
Pod Touch
upiD
. Provisioning Profiles
Al
Development
Dustribution © Register Multiple Devices

Upload a file containing the devices you wish to register. Please note that a maximum of
100 devices can be inchuded in your file and it may take a few minutes 1o process.
Download sample files

Choose File.
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Find the multiple-device-upload-ios.txt file that was created by DeployGate and then press
Continue.

renming
- Registering a New Device or Multiple Devices

Development

Production

B identifiers

Ape D6

Fro-Rebease Softwars Remindar
Pass Type in ioum Py enly ibure Apple pre-release ioftwane wath emplayees, cantradlors, and members of vour
Website Push Dy efganization who e regictenad a3 Agpls developers and Bave a3 able nedd 12 bno oF uie Apple

software 1o develop and test applications on your behalf.
Hloud Contarers

Ao Gt Unaethonzed & of Apple conf al infeemation deluding pre-releiie softawane) if prohibited and
may raawln in Thi cerminagion of your Apple Devilopsr Prageam, it may alse subject you 12 chl and risinal
Mierchant 1D
liabikey.
0 Devices
Al
Apple TV
Register Device
Apgie Walch Mame your device and enter its Unique Device Identifier (UDIDY.
iPad
Phone Name:
iFod Touwch
Ui
L Praviskaning Profilei
All
Development
Distribution © Register Multiple Devices

Upload a file containing the devices you wish to register. Flease note that a maximum of
100 devices can be included in your file and it may take a few minutes o process.
Drowndoad sample files

Cheiat File * multiple-desoe-upload-sos. st
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A review screen will be displayed which should list the name to be assigned to the device
along with the UDID associated with the device. Review to ensure this is correct and press
Register.

Pending

-l Review and register.
Development

Production

12| Identifiers

App IDs Confirm the device information is correct. Once this device is registered, you will not be able
to edit the UDID and can only edit the name or disable it.

Pass Type IDs

Website Push IDs

MName: dmoorel768 - iPad 3 (WiFi)
iCloud Containers

Model: iPad Wi-Fi (3rd generation)
App Groups UDID: 9f0a0d2b9979a4725d96bb1a136920db545ad917
Merchant IDs
[ Devices

All
Apple TV
Apple Watch You can register 96 more of this device type.
_ The maximum number of each device type that you can register per membership year is:
iPad

Apple TV: 100
iPhone Apple Watch: 100
iPod Touch !Pad: 100

iPhone: 100

[y Provisioning Profiles iPod Touch: 100

Al You may reset your device list at the start of your next membership year.
Development

Distribution
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At this point your device has been registered to your Apple Developer account. You now
need to add the device to the provisioning profile for your app. Select the provisioning
profile being used to test the app. Make sure your test device is checked in the list of
devices at the bottom of the screen. Press Generate.

Note: For the purposes of testing with DeployGate, an AdHoc type of provision profile must
be created and used. If you have not selected AdHoc, the list of devices will not be available

on the screen.

¢ Certificates
A
Pencing
Devesopment
-
o &
recne
identifers
Agp 1D
Pass Ty
Website Push IDs
ntamery
Apo ( Name
Merchant 10s
Type
o Devices
A App 1D
Ap v
Certificates
A Wat
iPad
Devices
Pire
Pod Touch

Provisioning Profiles
All
Development

Distribution

The following screen will display:

Modify your profile contents and select the Generate button to.save changes

Name Test Bible AdHoc
Expires Jul 29, 2016
Status ® Active

Test Bible AdHoc
O3S Distribution
Tost Btre (WEIMIILIWT.org kalaam tost. ScriphureAnD)

© Kalaam Media Ltd.(i0S Distribution

Select A
Eldwin’s IPad One
tidwin's iPhone 3GS

@ Cheis - Phone §

€ Dawvid Moore ~ IPod Touch (5 Gen)
Cheis Hubbard ~ IPhone 63

£ Davids 1Pad 2

Cance
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» veveoper
Certificates, Identifiers & Profiles
108, tvOS, watchOS v Edit |OS Provisioning Profiles
¢ Cenificmes

\9 Your provisioning profile is ready.

Download and Install

Download and double chick the following file 1o install your Provisioning Profile

&

ROV

Documentation
For more information on using and managing your Provisioning Profile read

Now you can download the new provisioning profile that has been generated.

Next you need to rebuild the iOS app using the new profile and upload it to DeployGate
again. This time when you attempt to install it, the Install button should be enabled and will
allow you to install your app.

13. Uploading iOS App to Apple App Store

Before attempting to upload the app, you will need to create an entry in App Store Connect
(https://appstoreconnect.apple.com).

Select the appropriate distribution Signing Identity and App Store provisioning profile on
the Signing (iOS) tab and click Build iOS App. This will create an IPA file in the IPA Output
Folder.

Launch Transporter and click Sign In using the Apple ID for your Apple Developer Account.
Drag and drop the IPA file from the IPA Output Folder to Transporter. Once the app is added
to Transporter, click on the Deliver button. After it is uploaded, you can click on the ...
button and select View in App Store Connect. Selecting the Activity tab will show the status
of the processing of the upload.
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14. Using Test Flight to Test an iOS App

It will take a little bit of time (around 20 minutes) for the app to be processed in App Store
Connect. You will receive an email when the app is done processing. Switching to the Test
Flight tab in App Store Connect, you will see that app is Missing Compliance.

~ Version 1.4

Build App Store Connect Users External Testers

[ 5 Missing Compliance

Click on the build number and you will be taken to a page where you can click on Provide
Export Compliance Information. The app uses an encryption algorithm to protect the text
of the app.

Click Yes to the first dialog that the app uses encryption and then click Next.

Export Compliance Information

Does your app use encryption? Select Yes even if your app only uses the
standard encryption within Apple's operating system.

Yes
No

Click Yes to the second dialog to indicate that the app qualifies for an exemption due to (b)
Limited to intellectual property and copyright protection and then click Start Internal
Testing.

Export Compliance Information

Does your app qualify for any of the exemptions provided in Category 5,
Part 2 of the U.S. Export Administration Regulations?

Yes
Mo

Make sure that your app meets the criteria of the exemption listed below. You
are responsible for the proper classification of your product. Incorrectly
classifying your app may lead to you being in violation of U.S. export laws and
could make you subject to penalties, including your app being removed from the
App Store.

You can select Yes for this question if the encryption of your app is:

(a) Specially designed for medical end-use

(b) Limited to intellectual property and copyright pratection

(c) Limited to authentication, digital signature, or the decryption of data or files
() Specially designed and limited for banking use or "money transactions”; or
(e) Limited to "fixed" data compression or coding technigues

39



You can add App Store Connect users (normally users in your organization) to test the app.
There is a link at the left for Add External Testers. This will require the app to go through
Beta App Review.

15. Apple Privacy Policy

Prior to publishing your app through App Store Connect, you will be required to complete
the privacy policy details section. The answers to these questions will be used to create the
privacy policy section in your app store entry that describes to the user how you are using
their data. The types of data associated with each question is documented by Apple at
https://developer.apple.com/app-store/app-privacy-details/. The answers associated with

the SAB app depend upon the use of analytics and what data is saved if you have user
registration defined for your app.

15.1. Data Types

Under the initial Data Collection screen in this section, if the app does not use analytics or
user registration, you may indicate that the app does not collect any data. If either of these
features are in use, then you should respond that we do collect data from this app. If you
answer Yes to this question, then you need to specify in the next screen the types of data
collected. For an app that has analytics enabled, Product Interaction under Usage Data and
Crash Data under Diagnostics should be selected. If the app has User Registration enabled,
then some of the fields under Contact Info may need to be checked depending upon the
fields you have configured for the user to enter.

15.2. Product Interaction

This section should only be required if analytics or user registration are enabled. If analytics
is enabled, then the Analytics entry should be checked to indicate that the data is being
used to track user behavior. If user registration is enabled, you may also want to check the
App Functionality entry. On the next screen, you should check the “No, product interaction
data collected from this app is not linked to the user’s identity” entry. On the final screen,
regarding tracking, you may click the “No, we do not product interaction data for tracking
purposes”,

15.3. Diagnostics

This section should only be required if analytics is enabled. The entry for Analytics should
be checked.

16. Building from Terminal

Scripture App Builder has a command line interface which allows you to create a new app
and build it, or load an existing app and build it.
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The base command calls java to access the jar file within the Scripture App Builder
application followed by a series of options described below. The base command is:

java -jar "/Applications/Scripture App
Builder.app/Contents/Java/bin/scripture-app-builder.jar"

The available parameters are:

Option

Description

-—new

Create a new app project

-load <project>

Load an existing app project

~build Build app project (use with either -new or -load)
-no-save Do not save changes to app (use with -load)
-resign Resign iOS Template App (use with either -new or -load)

Show command line help

-n <app-name>

Set app name.
Enclose the name in "double quotes" if it contains spaces.

-p <package-name>

Set package name, e.g. com.myorg.language.appname

-b <filename>

Add book or bundle file. This could be a USFM file or a
zipped set of USFM files. It could also be a Digital Bible
Library text release bundle.

-i <filename>

Include additional parameters file.
Use the full path of the file and enclose it in "double quotes"
if there is a space in the path.

-a <filename>

Set about box text, contained in text file.
Use the full path of the file and enclose it in "double quotes"
if there is a space in the path.

-f <fontname>

Set font name or filename, e.g. "Charis SIL Compact",
"c:\fonts\myfont.ttf"

The font name must be one of the items in the list of fonts
in the New App wizard. For other fonts, specify the full path
to the font filename.

Use Grandroid
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-ic <filename>

Add launcher icon (one or more .png files).
Use the full path of the files and enclose them in "double
quotes" if there is a space in the path.

-1 <lang-code>

Set language for menu items and settings, e.g. en, fr, es

-ft <feature=value>

Set a feature, e.g. book-select=grid

-vc <integer>

Set version code, e.g. 1, 2, 3, or +1 to increment the current
version code by 1.

-vn <string>

Set version name, e.g. 1.0, 2.1.4, or use +1, +0.1, +0.0.1 to
increment the current value.

-ks <filename>

Set keystore filename.
Use the full path of the file and enclose it in "double quotes"
if there is a space in the path.

-ksp <password>

Set keystore password

-ka <alias>

Set key alias

-kap <password>

Set key alias password

-fp <folder=path>

Set a folder path, e.g. "app.builder=c:\Scripture App
Builder".

-ta <target-api>

Set Target API, e.g. 21 for Android 5.0, 22 for Android 5.1.

-si <signing
identity>

Set Signing Identity to use for iOS Resigning

-pp <provisioning
profile>

Set full path to provisioning profile for iOS resigning

-bn <integer>

Set build number for ipa file, e.g. 1, 2, 3, or +1 to increment
by 1

-vs <string>

Set version string for ipa file, e.g. 1.0, 2.1.4 or +1, +0.1,
+0.0.1

Examples:

Java -jar

"/Applications/Scripture App Builder.app/Contents/Java/bin/scripture-app-
builder.jar" -load "Mali" -resign -bn "5" -vs "2.3.2" -si "iPhone Distribution:

Summer Institute of Linguistics,

Inc (SIL) (4YF5X97M4H) "

-pp
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"/Users/builder/Documents/MobileProvision/AdHoc org.wycliffe.app.mali.mobileprovisi

on"

17. Using Firebase in an iOS App

The Building Apps document contains general information about setting up the app to
support Firebase Analytics, Crashlytics, Messaging and Real Time Database. This section will
focus on the steps required to make these features work with an iOS app.

17.1. Adding aniOS App
The first step is to go to your Firebase Console (https://console.firebase.google.com/u/0/)

and select the entry for the application you are working on. Press the “Add App” button,
then select the iOS button.
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The next screen will request general information about your application. The iOS bundle ID
should match the Bundle ID for the app. This is the SAB Package setting from the Package
Tab for the App unless a separate Bundle ID is set in the IPA Tab . The App Nickname can be
set to whatever you want this app to be referenced as within Firebase. The App Store ID is
the same as the Apple ID field in the SAB IPA tab described in Section 9. Once these fields
are entered press “Register App”.

x  Add Firebase to your iOS app

° Register app

i0S bundle ID @

org.sil.sample

App nickname (optional) (&

Sample App

App Store ID (optional) @

l 1234567890

Register app

o Download config file
e Add Firebase SDK
o Add initialization code

o Next steps
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The next screen allows you to download the config file for the application. Press “Download
GoogleServicelnfo.plist” to download the Firebase configuration file to your local machine.
It should be mentioned here that if your app has the Real Time Database option set in SAB
and you have not yet configured the Real Time Database within Firebase Console, you
should either do that first or download the plist file again after that configuration has been
completed. Download the file to a location where you can locate it. Later in this section,
instructions will be provided for adding this file into your SAB application. After
downloading the file, press “Next” to continue.

x  Add Firebase to your iOS app

° Register

app
ID: org

sil.sample, App nickname: Sample App, App Store ID: 1234567891

0 Download config file Instructions for Xcode below jnity Cé+

¥ Download GoogleService-Info.plist

Move the GoogleService-Info.plist file you just downloaded into the root of your Xcode project and add it to
all targets

B g aQ A H D
v & MyApplication
¥ [ MyApplication

= AppDelegate.swift

= ViewController.swift
Main.storyboard
Assets.xcassets

GoogleService-Info.plist LaunchScreen.storyboard
Info.plist
B GoogleService-Info.plist

- Dradiiste

© Add Firebase SDK
o Add initialization code

© Nextsteps

The screens which follow the download step are all instructional screens providing
information about programming changes that need to be made to add Firebase to an app.
This work has already been done within SAB and can be ignored here.

45



The final screen just provides a means to return to the console. The addition of the iOS app
to the Firebase console is complete.

x  Add Firebase to your iOS app

° Register app
i0S bundle ID: org.sil.sample, App nickname: Sample App, App Store |D: 1234567890

o Download config file

Add Firebase SDK

Next steps

o
@ Add initialization code
o

You're all set!

Make sure to check out the documentation [ to learn how to get started with each Firebase product that
you want to use in your app.

You can also explore sample Firebase apps .

Or, continue to the console to explore Firebase.

Previous Continue to console
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17.2. iOS Configuration for Firebase in SAB

After the app has been added to the Firebase configuration through Firebase Console, the
configuration file that was downloaded needs to be added to SAB. On the Firebase tab, in
the Firebase Configuration section on the bottom half of the screen, press the iOS tab.
Press the Browse button to locate the GoogleService-Info.plist file that was downloaded
during the Firebase configuration process above. Select that file to add it to the app
configuration. Note that if Firebase features are checked as enabled, the iOS app will not
build until the plist file has been added.

Kuna Gospels: App

App Name Package Project  APK IPA  Signing (Android) ~ Signing ((0S) = Expiry Firebase Deep Linking ~ Security Permissions

Firebase can provide a range of tools for your app, such as analytics, crash reporting and push notifications. To use Firebase in your app, create a Firsbase projact for the app and specify the
configuration details below.

Firebase Features
Which Firebase features would you like to use in this app?
+ Firebase Analytics (for tracking app usage and user engagement)
+ Firebase Crashlytics (for crash reporting)
| Firebase Messaging (for push notifications)
| Firebase Realtime Database (for saving user details)

Firebase Configuration

Android i0S  Web

Specify the Firebase configuration file for iOS (GoogleService-Info.plist). This can be downloaded from your Firebase Project Settings page.

<?xml version="1.0" encoding="UTF-8"?> Browse...
<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0#/EN" "http://www.apple.com/DTDs/PropertyList-1.0.dtd">

<plist version="1.0"> Clear
<dict>

<key>CLIENT_ID</key>

<strina>920861788030-018k5a5madr1m8itBulShBcoloT4abi4. apos. acoaleusercontent.com</strina> Open Console...
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17.3. Security Feature Support iniOS App

The iOS app supports a subset of the security features available in SAB. These features can
be accessed through the Security tab within SAB. iOS only supports the default Allow
anyone to use this app and the Require each user to register with the details when they first
use the app features. The other features are available for Android apps but are not
implemented in the iOS app at this time. The registration configuration for this feature
works identically for both Android and iOS. No special steps have to be taken specifically for
iOS to configure this option if it is selected.

Kuna Gospels: App

App Name  Package Project APK IPA  Signing (Android)  Signing (OS)  Expiry  Firebase = Deep Linking  Security = Permissions
Compression and Encryption

By default, App Builder will compress and encrypt the data in the app. This significantly reduces app size. Tum compression off if you want to use the editor feature.

¥ Compress and encrypt data in the app

Restricted Users
You can choose to allow anyone to use this app or restrict its use to a limited number of known devices. The restricted option could be useful if you are testing the app with a small group of
people and want to make sure it is not distributed any further.

Allow anyone to install and use this app

Allow only selected devices to use this app
Require a device-specific access code to use this app

#) Require each user to register with their details when they first use the app
Configure Registration...

Show a calculator on start-up. Entering a code will give access to the app content.

17.4. Firebase Messaging

If Firebase Cloud Messaging is configured to allow push notifications for the app, several
changes are required for the app’s configuration information in the Apple App Store. The
first thing that is required is that the App’s configuration must be changed in Apple
Developer to include Push Notifications. Under Certficates, Identifiers, and Profiles, select
the app that is being configured. Enable the Push Notifications option from the list.

N)) NFC Tag Reading

Personal VPN

j Push Notifications onfigure Certificates (0)
® Sign In with Apple
@ SiriKit

@ System Extension
° Time Sensitive Notifications
(@ User Management
C =] wallet

= Wireless Accessory Configuration

= Ry SRR
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After making these changes, the provisioning profile for the app should be updated for the
new capability and the entry updated in SAB.

For Firebase to send notification to the app, it will need to have a key uploaded to it. The
preferred manner is to go to the Keys section in Apple Developer and select to create an
Apple Push Notifications service key, using the first option on the screen below. One key of
this type is created to be used with all apps associated with this organization. If a key has
already been created, then use that.

“ Developer
Certificates, Identifiers & Profiles

Register a New Key

Key Name

ENABLE NAME JESCRIPTION

Establish connectivity between your notification server and the Apple Push
Apple Push Notifications service (APNs) plish Y Y ! PP Fue
Notification service. One key is used for all of your apps. Learn more

Access the DeviceCheck and AppAttest APls to get data that your associated
DeviceCheck server can use in its business logic to protect your business while maintaining user
privacy. Learn more

Publish all of your ClassKit app activities to teachers creating Handouts in Apple

ClasskKit Catalog Schoohwork. Learn mor

At the time the key is created, a .p8 file is generated which can be used for all apps. You are
allowed to make two keys through this interface, so that you can create a new key and
revoke the old one, but only one is active at a time.
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Certificates, Identifiers & Profiles

< All Keys

View Key Details revoke | [ ea

Name
SIL APNS

Key ID
55438BX8MT

Enabled Services

NAME CONFIGURATION

Apple Push Notifications service (APNs)

Once the p8 file for this key has been downloaded, the file can be uploaded to the Firebase
configuration for cloud messaging for this app.

Project settings

General  Cloud Messaging Integrations  Service accounts  Dataprivacy  Users and permissions  App Check seTa

Project credentials

Add server key

Key Token

AAAAVZW_Igl:APAS1bHGkdHSCPgITIIUSJEX-W-

AlHMzeynfJeLli2lldmakKnnzLm6BnjpXzHgkEN3GwWGLQw
ZRdOygMPJY_mGjCgWkSA0EEvM-SubRFITdQ S5 0

Server key 0

Sender ID (O

367584581282

i0S app configuration

0S apps
105 app: Firebase Cloud Messaging can use either an APNs authentication key or APNs certificate to connect

with APNs

05 ) English Greek
N /" org.wycliffe.app englishgreek2

APNs Authentication Key

File Key ID Team ID
IXMT CEAWERL A0
B APNs Auth Key s FVEAWERLEC
APNs Certificates w
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17.5. Firebase Crashlytics for iOS

If Crashlytics is configured for the app in Firebase, the dSYM file associated with the app
should be uploaded to get the detailed information about any crashes. To upload dSYMs,
you’ll need to use the upload-symbols command line tool that ships with the Crashlytics
SDK. One way to obtain the tool is to install the Crashlytics SDK and locate the tool in the
“FirebaseCrashlytics” folder where you installed the SDK. The tool has also been uploaded
to an App Builder share drive. The link to this file is:
https://drive.google.com/file/d/1RJIDZyQUbfhoqg91GZg1YggNMJQQVeue/view?usp=sharin

g
After downloading this file, cd to the download location and enter “chmod +x upload-

symbols” to make the script executable. Otherwise a “Permission denied” may be
encountered when attempting to run the script.

The dSYM file that is required is supplied as part of the build process if Crashlytics is
configured for the application. The dSYM file is created in the ipa output folder with the
same name as the ipa file, with a dSYM extension.

Upload the dSYM file using the GoogleService-Info.plist file associated with this application
by opening a Terminal window. The command line to upload the dSYM file is:
/path/to/upload-symbols -gsp /path/to/GoogleService-Info.plist -p ios
/path/to/TemplateApp.app.dSYM
For the example where all three files have been placed in the same directory and the
Terminal window has cd’d to that directory, the command would be:
.Jupload-symbols -gsp ./GoogleService-Info.plist -p ios ./TemplateApp.app.dSYM

18. Deep Linking for iOS

The iOS version of SAB now supports Deep Linking. Within SAB, the setup of this feature for
an app is identical to what is described in the Scripture App Builder: Building Apps section

on Deep Linking. Additional steps are required for iOS depending upon the deep linking
configurations required.

18.1. Provisioning Profile Changes (Associated Domains)
Any type of deep linking configuration will require updates to the app configuration in Apple
Developer. The definition of the app in Apple Developer must be updated to include the
Associated Domains capability. To update an app, perform the following steps:

e Loginto your Apple Developer Account

e Select “Certificates, IDs and Profiles” from the main menu

e Select “Identifiers” from the menu on the screen that appears. This will provide a list

of the apps that have already been created.
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e Select the app that you are adding the Deep Linking capability to.
e A screen similar to the one below should display:
& Developer -

Certificates, Identifiers & Profiles

18.2.

Edit your App ID Configuration

Capabilities App Services

@)\ Access WIiFi Information
-
B8 App Groups

‘ Apple Pay Payment Processing

@ Associated Domains

[S) autcFill Credential Provider

@ Communication Notifications

- Custom Network Protocol

Check the “Enabled” box in front of “Associated Domains” and then press “Save”.
This will generate a warning that adding or removing capabilities will invalidate your
current provisioning profiles. Press “Confirm” to continue

Select “Profiles” from the menu on the left to get access to the Provisioning Profile
for the app.

Select the provisioning profile associated with this app (which should be listed as
“Invalid”) and press “Edit”

No changes should be required. “Associated Domains” should appear in the list of
“Enabled Capabilities”. Press “Save”.

Press “Download” to download the provisioning profile to the system where SAB is
installed and update the “Profile File” entry on the “Signing iOS” tab to point to the
updated provisioning profile.

Deep Linking using URL Scheme

A URL that supports deep linking for an iOS app must contain an Associated Domain File.
The section “Add the Associated Domain File to Your Website” in

https://developer.apple.com/documentation/xcode/supporting-associated-domains

describes the required changes. As is stated in this article, the page must be accessible via
https://.

An example apple-app-site-association file that was used for testing is:

{
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"applinks": {
"apps": ],
"details": [

{

"appID": "3YEAWS86L3G.org.wycliffe.app.sabtest”,
"pathS": [II*II]

}
]
}
}

18.3. Deferred Deep Linking — Using Branch

When Branch.io is used to implement deferred deep linking, the Branch dashboard must be

filled out to indicate that you have an iOS app. The following is an excerpt from a web page

that describes all of the steps needed to use Branch.io for an iOS app. Most of the

information there is already done by either SAB or the template app.

https://medium.com/flawless-app-stories/ios-universal-links-and-app-referrals-using-

branchio-integration-31dd474be20

On branch dashboard under link settings, tick iOS and enter below details:

iOS Url Scheme: If the app is registered with some scheme then we need to
specify here. When a referral/universal link is clicked then it will use scheme to
launch the app.

Apple Store Search: If the app is not installed then you can redirect the user to
the App Store for that particular app. Search your app here by name.

Custom URL: You can also redirect the user to a particular website instead of the
App Store. This might be a case where either of one platform(iOS or Android) is
supported and for the other, you want to redirect the user to a website for
further communication.

Bundle Id: Give the bundle id of the app.

Apple App Prefix: The App prefix can be retrieved from app developer account
or even from Xcode -> General -> Signing. It is just a Team Id.
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@& Developer Account

-

@ Membership
Membership Details

ple Your team's membership information and legal agreements.

Program Type Apple Developer Program

TeamName | |

Entity Type Company / Organization

tatior Phone I I

nloa Address

Expiration Date I I

@ Chrome File Edit View History Bookmarks People Window Help @ & = 70x®) Mon9Sep 244PM Q @ =

Da: d - Branch Metrics

C @ dashboard.branch.io; % Incognito @

branc‘ﬁ Link Settings EX © simow
°

GENERAL

General URI Scheme Deep Link
Mode

gent Mode -

i0S URI Scheme

i0S o we thinkthe

I have an i0S App
’

© Apple Store Search Custom URL
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